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AX SoftJACE Install & Startup Guide
This document covers the initial software installation and configuration for the AX SoftJACE, using 
either NiagaraAX-3.8 (AX-3.8) or NiagaraAX-3.7 (AX-3.7). It assumes that you are an engineer, 
technician, or service person who is performing control system installation. This document is also in 
NiagaraAX Workbench help, providing that the “docSoftJace” module is installed.

Note: This document does not cover station configuration or NiagaraAX components. For more information on 
these topics, please refer to NiagaraAX Workbench online help and the NiagaraAX User Guide.
The following sections are in this document:
• “Product Description” on page 2-2

• “Options and drivers” on page 2-2
• “Host PC Requirements” on page 2-2
• “Included in the SoftJACE package” on page 2-3
• “Download and extract the SoftJACE image” on page 2-3

• “Installation and startup overview” on page 2-4
• “Notes on 32-bit versus 64-bit SoftJACE installations” on page 2-4
• “SoftJACE Windows security notes” on page 2-4

• “Install the SoftJACE software” on page 2-5
• “SoftJACE licensing considerations” on page 2-7

• “About the SoftJACE license” on page 2-7
• “Resource limits” on page 2-8
• “Submitting a license request” on page 2-9
• “Manually checking host ID and submitting license request” on page 2-10
• “Installing the SoftJACE license” on page 2-11

• “Connect to the SoftJACE” on page 2-11
• “Open a SoftJACE platform connection” on page 2-11

• “Run the Commissioning Wizard” on page 2-14
• “About the Commissioning Wizard” on page 2-14
• “Start the Commissioning Wizard” on page 2-15
• “Request or install software licenses” on page 2-16
• “Set module content filter level” on page 2-17
• “Station installation” on page 2-17
• “Install lexicons” on page 2-18
• “Install/upgrade modules” on page 2-19
• “Install/upgrade SoftJACE core software” on page 2-20
• “TCP/IP configuration” on page 2-21
• “Platform daemon authentication” on page 2-22
• “Review and finish wizard” on page 2-24

• “Post-wizard SoftJACE configuration” on page 2-25
• “SoftJACE platform administration” on page 2-25

– “Administer the SoftJACE platform” on page 2-25
• “SoftJACE Platform Services” on page 2-28

– “PlatformServices properties in a SoftJACE” on page 2-29
• “Software port notes” on page 2-30
• “SSL and certificate notes in AX-3.8” on page 2-30
• “AX SoftJACE FAQs” on page 2-31
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• “Document change log” on page 2-32

Product Description
The AX SoftJACE is NiagaraAX Framework software that runs on a user-supplied PC, providing many of 
the same benefits as a JACE controller. Depending on the SoftJACE host PC’s Windows operating system, 
you may select a 32-bit (or if applicable) 64-bit SoftJACE installation. The PC must meet the minimum 
requirements stated in the AX SoftJACE data sheet, and be dedicated to the SoftJACE application, that 
is a single-purpose host. Additional host requirements apply—see “Host PC Requirements” on page 2-2.
A SoftJACE running AX-3.7 or AX-3.8 supports enabling secure (SSL and/or TLS) connectivity to its 
Niagara platform and station. Station access applies to both Workbench/Niagara station (Foxs), as well 
as browser (HTTPS) access to the station, the latter via its standard Web User Interface feature.
The SoftJACE package consists of a software installation CD (or downloaded SoftJACE image) and this 
document. At the SoftJACE PC, you typically use a CD/DVD drive and local console (keyboard, mouse, 
and monitor) for the initial software installation. Alternatively (and if so enabled), you can use a Windows 
“Remote Desktop Connection” to transfer SoftJACE installation image files to the SoftJACE host PC, and 
then run the setup.exe or setup_x64.exe install executable remotely, over such a connection.
Thereafter, to complete startup configuration, you need to access the SoftJACE host remotely using a 
platform connection from Workbench running on a another NiagaraAX PC, such as a Supervisor or 
NiagaraAX engineering workstation.

Note: As with any JACE controller using NiagaraAX, an AX SoftJACE is not licensed to run full Workbench, 
meaning it cannot perform “client platform operations,” nor operate as a full engineering workstation. 
Therefore, the station for a SoftJACE is typically engineered on another NiagaraAX PC, then installed and 
started over a network connection using NiagaraAX platform tools. See the next section “Options and 
drivers” for related details.

Options and drivers
Installation provides a complete set of Java™ based control, application, and user interface objects using 
installed modules. When provided with a connection to a LAN or the Internet, the SoftJACE can serve 
graphical views of the control system to any standard Internet browser.
Also over an Ethernet network, the SoftJACE can communicate to various devices and/or other systems, 
and interoperably share data between them. Drivers for the Niagara Network (Fox/Foxs client/server) 
and oBIX client/server are standard. Other optional drivers are listed below.
Note that only NiagaraAX drivers using Ethernet connectivity are supported.

Note: Drivers using other connectivity types (e.g. LonWorks FTT-10, serial RS-232, RS-485) are not supported.
At the time of this document update, a few of the additional driver options include:
• BACnet IP Client (DR-BACNET-AX)
• BACnet IP Server and Client Bundle (DR-BAC-SR-AX)
• LON over IP (DR-ILON-AX)
• OPC Client (DR-OPC-CL-AX)
• Modbus TCP (DR-MDB-TCP-AX)
• SNMP (DR-SNMP-AX)
Yet more driver options, including various video drivers, are also available. An option for “Embedded 
Workbench” is also available, allowing “Web Workbench” access to the SoftJACE station via a web 
browser. However, note that such Workbench access does not provide platform connectivity.
For more details on available options, see the AX SoftJACE data sheet and your master price list.

Host PC Requirements
The minimum PC requirements for an AX-3.7 or AX-3.8 SoftJACE are as follows:
• PC platform with Intel or AMD CPU, 400 MHz or higher. A recommended minimum CPU is at least 

an Intel Pentium Core 2 Duo, 2 GHz or higher, or an equivalent AMD CPU. The CPU must be com-
patible with the Windows operating system. Please note that unlike in early NiagaraAX releases, a 
“multi core processor” does provide performance benefits in Niagara.

• Windows1 operating system, for example Windows 7 Professional/Enterprise/Ultimate (32-bit or 
64-bit), Windows Server 2003 or 2008 (32-bit or 64-bit). 
If AX-3.8, Windows 8 Professional and Windows Server 2012 are also supported (32-bit or 64-bit).
NiagaraAX-3.7, -3.8
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For a compatibility listing of Windows operating systems for various Niagara products, see the 
knowledge base article on the Niagara-Central website: Supported Windows Operating Systems (at 
the time of this document update, at the following URL):
https://community.niagara-central.com/ord?portal:/dev/wiki/Supported_Windows_Operating_Systems

• 2GB or more system RAM (4GB or more recommended if a 64-bit Windows OS).
• 2GB or more of available hard drive space, with 10GB minimum drive space recommended.
• An Ethernet 100 Mbit or 1Gbit NIC (network interface card), with TCP/IP support, to use for pri-

mary access. If desired, an additional NIC or WiFi adapter (801.11b/g) may be optionally utilized by 
some NiagaraAX drivers, to isolate the driver’s network traffic.

• For the initial loading of software, either a CDROM drive, along with keyboard, mouse, and monitor, 
or the SoftJACE host configured to support a Windows Remote Desktop Connection.

Before beginning installation, the PC’s Windows OS should be configured for TCP/IP networking 
support. A standard Java-enabled browser, such as Microsoft Internet Explorer, should be installed and 
tested as operational. The latest Windows OS security updates and patches should also be installed—see 
“SoftJACE Windows security notes” on page 2-4.
By default, software installation creates a Niagara home directory on drive C:, and copies all files needed 
under it. During installation, you can designate another target install directory, including a different drive 
partition (for example drive D:) if desired.

Included in the SoftJACE package
Included in this package you should find the following items:
• A SoftJACE installation CD. In lieu of a CD, you may be directed to download a SoftJACE image file 

from the Niagara-Central website. The image is the CD contents in a compressed (.zip) file. See 
“Download and extract the SoftJACE image”.

• A unique license key you can use to get and install the SoftJACE license on your PC.
• This document, AX SoftJACE Install & Startup Guide.

Note: Limits of a SoftJACE are set entirely in its (brand) license file. Typically, you receive this as an email 
attachment, after you submit a license request to the license authority for your host PC. For more details 
see, “About the SoftJACE license” on page 2-7.

Download and extract the SoftJACE image
Unless you have a SoftJACE CD, first download the latest SoftJACE image from Niagara Central. This 
topic explains how you must extract the files from the image download before running the setup program. 
It also describes transferring the extracted image files to a remote PC for installation.

Figure 1 Example files extracted from a downloaded AX SoftJACE image

Note the SoftJACE CD or image may include “Install_Type_Tunnel.exe” and/or 
“InstallVserialAx2.exe” files, as shown in Figure 1 above. These are unrelated and unused in any 
SoftJACE installation, but are available to install on other client PCs, if needed. For details, see “Serial 
tunneling” in the NiagaraAX Drivers Guide and “Lon tunneling” in the NiagaraAX Lonworks Guide.

1. Because of Microsoft soon ending technical support for Windows XP, this operating system is not recommended. 
Note if using a Windows Server product, then its IIS server may need to be disabled to prevent conflicts with the 
station’s web server, providing it is configured to run on the (non-secure) HTTP port 80.
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To download and extract SoftJACE image files

Step 1 Log in to the Software portion of the Niagara-Central website. At the time of this document update:  
(https://community.niagara-central.com/ord?portal:/download)

Step 2 Download the latest AX-3.8 or AX-3.7 SoftJACE image. 

Step 3 Extract (unzip) its contents to a local folder.
Note: You must extract (unzip) the image file to a local folder before starting any install, and use the unzipped 

files for the installation. Although Windows 7 and later allow you to see the contents of a compressed zip 
file—and even launch an executable without extracting files, such an attempt to install an AX SoftJACE 
this way will fail.

Step 4 If you are working at the AX SoftJACE PC, you are now ready to start the installation. See “Installation 
and startup overview” on page 2-4.

Step 5 If the AX SoftJACE PC is remote, open a Windows Remote Desktop connection to it. Copy the local 
folder with extracted SoftJACE image files (or the contents of the SoftJACE CD) to a folder on the remote 
AX SoftJACE PC. Once the folder is copied, you are ready to start the installation. See “Installation and 
startup overview” on page 2-4.

Installation and startup overview
Please read through the entire document before beginning the installation procedures.

Note: An administrator-level Windows user account and password for the host PC is required to install the 
SoftJACE software. In addition, you require another PC installed with NiagaraAX Workbench to finish the 
SoftJACE configuration and station startup, as described in this document. Finally, please see the next 
sections, “Notes on 32-bit versus 64-bit SoftJACE installations” and “SoftJACE Windows security notes”, 
including firewall considerations (“Platform daemon port” on page 2-5).
The following main tasks are described ahead:
1. “Install the SoftJACE software” on page 2-5.
2. “SoftJACE licensing considerations” on page 2-7.
3. “Connect to the SoftJACE” on page 2-11.
4. “Run the Commissioning Wizard” on page 2-14.
5. “Post-wizard SoftJACE configuration” on page 2-25.

Notes on 32-bit versus 64-bit SoftJACE installations
Many newer Windows PCs run a 64-bit operating system (OS), typically Windows 7 or later. The AX 
SoftJACE offers a 64-bit install, which provides certain advantages—most notably the 64-bit Java VM 
(Virtual Machine) does not have a 2GB memory limit. Coupled with the typical 4GB or more of RAM 
installed on such a Windows, this can allow a SoftJACE with a large station to run more effectively.  
A 64-bit install may also provide other benefits, depending on the host’s CPU architecture. 
Therefore, for a SoftJACE PC running a 64-bit Windows OS, you should choose a 64-bit installation 
(setup_x64.exe on the AX SoftJACE CD, or from image download files), in almost all cases.
A possible (but unlikely) exception is if the host PC uses a 64-bit Windows OS, but has less than 4GB of 
RAM. In this case, the shorter 32-bit memory pointers could be advantageous. Note that the exact same 
station running in a 64-bit VM will require more memory than if running in a 32-bit VM.
Note that in any 32-bit Windows OS, if you try to install by selecting setup_x64.exe, the NiagaraAX 
installation wizard does not start. An error popup tells you it is “not a valid Win32 application”.

Note: Keep in mind that on the same 64-bit Windows host, a 32-bit install and a 64-bit install result in different 
Niagara host IDs. This may cause licensing confusion if you install (and license) a 32-bit installation first, 
and then re-install as 64-bit—or vice versa.

SoftJACE Windows security notes
Before beginning SoftJACE installation, it is strongly recommended you download and install the latest 
Windows security patches from Microsoft, for the specific Windows OS running on your SoftJACE. 
Specific details are outside the scope of this startup document.
NiagaraAX-3.7, -3.8
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Caution Typically, installation of Microsoft Windows OS updates and/or security patches ends with a system 
reboot. Although this does not matter for a new SoftJACE (without a working station), please keep this in 
mind whenever installing future Windows operating system updates—using the NiagaraAX backup 
feature, always backup your SoftJACE to your Workbench PC first, before installing updates!

A firewall program on the SoftJACE is typically enabled (e.g. the Windows Firewall). SoftJACE 
platform commissioning often requires firewall adjustments—see the “Platform daemon port” section.

Platform daemon port
After installing the AX SoftJACE software, in order to initially commission the SoftJACE, TCP port 3011 
(and/or if using SSL, TCP port 5011) must be accessible. This is needed for a platform connection from 
another Workbench PC, so it may run the Commissioning Wizard. 
Figure 2 shows a “NiagaraPlatform” inbound rule that has been added to the Windows Firewall in 
Windows 7 Professional (Advanced Settings) on a SoftJACE, configured to open TCP ports 3011 and 5011.

Figure 2 Windows 7 Firewall 

Note that during SoftJACE commissioning, you may elect to change this port from 3011 (or if using SSL, 
5011) to another port number (see “Administer the SoftJACE platform” on page 2-25). If you do this, 
afterwards be sure to adjust any firewall accordingly. 
Additionally, during the commissioning process, other ports also typically need to be opened in the same 
way to allow proper station operation. See “Software port notes” on page 2-30, which includes a table of 
commonly used ports in NiagaraAX.

Install the SoftJACE software
The SoftJACE CD (or the same files expanded from a downloaded AX SoftJACE image) includes the 
necessary NiagaraAX Framework software.

Note: Prerequisites: Update the Windows OS to the latest Windows security patches and decide if a 64-bit install 
or 32-bit AX SoftJACE install is appropriate. If installing from a downloaded AX SoftJACE image, extract 
the zipped image first. See “Notes on 32-bit versus 64-bit SoftJACE installations” on page 2-4, “SoftJACE 
Windows security notes” on page 2-4 and “Download and extract the SoftJACE image” on page 2-3.

To install the SoftJACE software
At the SoftJACE PC, do the following steps:

Step 1 Close all open applications.
If installing to a remote PC, open a Windows Remote Desktop Connection to it, and close any 
applications running on it.

Step 2 If working at the SoftJACE PC, insert the AX SoftJACE CD into the PC’s CD drive.
NiagaraAX-3.7, -3.8
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Step 3 Using Windows Explorer, navigate to the root of the SoftJACE CD (if applicable), or to the folder with the 
files extracted from the downloaded AX SoftJACE image.

Step 4 Double-click either the setup_x64.exe file or setup.exe file, depending on whether a 64-bit or 32-
bit installation. The first step in the Installation wizard appears.

Step 5 Click Next to begin the install process.

Step 6 In the License Agreement step, read and then click Yes to agree to it, then click Next.

Step 7 In the Select Install Location step, specify the target installation folder. By default, the 
destination folder is C:\Niagara\Rel 

You can specify another drive, if desired. The default Niagara\Rel folder is generally recommended—
this is the same system home directory for any dedicated JACE.
To specify another location, type it in, or click Browse to navigate to a different folder and/or drive.
The Refresh button recomputes the “Space Available” statistic, and can be useful if you have changed 
the target drive location from default C: to another drive partition.

Step 8 When your destination folder is specified, click Next. If a new folder, a confirmation dialog appears.

Click Yes to proceed, or No to return to the install wizard.

Step 9 In the Select Options step, you can select whether shortcuts are installed on the Windows Start 
menu only (default) and/or on the desktop. If an AX-3.8 SoftJACE install to a Windows 8 (or Windows 
Server 2012) PC, the first (and default) option is “Install Start Screen Tiles”.

Note: It is recommended to accept the default to install shortcuts to the Windows Start menu or Start 
Screen Tiles. Among the shortcuts, only “Console” has a typical application with an AX SoftJACE.
Click Next to launch the installation.

Step 10 Files are installed to your destination folder as a progress bar displays.
NiagaraAX-3.7, -3.8
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When all files are installed, a Finish Install dialog appears.

Step 11 In the Finish Install dialog, click Next to finish the installation.

Installation of all needed software is now complete.
Note: Installation automatically installs and starts the Niagara platform daemon, which runs as a Windows 

service on the SoftJACE PC. The platform daemon is required to support running a station, as well as act 
as the server for platform connections (from PCs running the Workbench client). For more platform 
connection details, see “About a platform connection” in the Platform Guide.

SoftJACE licensing considerations
The following topics provide SoftJACE license details:
• About the SoftJACE license
• Resource limits
• Submitting a license request
• Manually checking host ID and submitting license request
• Installing the SoftJACE license

About the SoftJACE license
As with any NiagaraAX platform, a SoftJACE requires at least one valid license file for operation. Each 
license file is specific to the installed host (in this case a specific PC), by its “host ID”, which NiagaraAX 
uniquely calculates for any device. The host ID is in the first line of the license file (a digitally-signed text/
xml file).
• For any JACE controller, its host ID is determined at the factory, and a corresponding license file for 

that specific JACE is finished and stored on a “licensing server.” This simplifies the installation or 
updating of the JACE’s license during commissioning, making the process almost automatic.

• Your SoftJACE PC host ID cannot be determined until after the NiagaraAX software is installed.
However, when you buy a SoftJACE, a license file is started for it—and also stored on the licensing server. 
In this “unbound” license, there is a “license key” entry, a hexadecimal number that is also printed and 
sent to you. See Figure 3 for a license key example (FF01-0000-AF15-008B-7799).

Figure 3 Example sheet showing unique License Key

After you install the NiagaraAX SoftJACE software, you can submit an online form to the licensing server, 
on which your NiagaraAX-calculated host ID appears. You enter your license key along with your name, 
company, and email address. 
Using this “self serve” process, the licensing server can immediately finish your license, where it is then 
available for SoftJACE commissioning (when using your Workbench PC). Also, the license file is emailed 
back to you as an attachment. See “Submitting a license request” on page 2-9.
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Caution A license file is a digitally-signed text/xml file, which you can open and read with Wordpad or Internet 
Explorer, and even rename if desired. However, never edit the contents of license file! If you make any 
changes to contents, your SoftJACE will not operate! Contact your license authority if you need any changes, 
so that your license can be updated properly.

Note that your SoftJACE license has resource limits, meaning that the station running on it has a pre-
allocated amount of Java resource units for objects. See the section “Resource limits” for more details.

Resource limits
The entry in a (brand) license most unique to a SoftJACE is the “resource.limit” number found in the 
“station” section, for example:

<feature name="station" expiration="2014-11-18" resource.limit="10000" 
    parts="SJ-1M-AX"/> 

In this license example, any station running on the SoftJACE is limited to a maximum of 10,000 kRU (kilo 
Resource Units). Above this limit, a yellow-highlighted warning appears in all views of the station, 
including wire sheets, property sheets, Px views—even when accessed via browser. See Figure 4.

Figure 4 SoftJACE resource limit exceeded warning (seen in any view of its station)

Furthermore, a warning informs you when the station SoftJACE restarts (Figure 5), and in some cases 
may keep the station from starting.

Figure 5 SoftJACE station restart failure example

You can check the resource unit count of any running station that is opened in Workbench. Simply right-
click the station node in the Nav tree, and select Views > Resource Manager (Figure 6 on page 9).
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Figure 6 Resource Manager reports resource limit and current total

If a SoftJACE is over its capacity (yellow warning as shown in Figure 4 on page 8), reduce the number of 
station components until the total resources are within its license limit. Contact your vendor to see if you 
can purchase additional resource unit capacity.

Submitting a license request
If your SoftJACE PC has Internet connectivity, and you have your license key (Figure 3 on page 7), after 
installing the software you can submit a “Bind License” form to the licensing server. This can immediately 
“finalize” (bind) your unbound license file, whereby you can automatically retrieve it when commis-
sioning the SoftJACE, as well as have it emailed to you.

Note: If the SoftJACE PC does not have Internet connectivity, see “Manually checking host ID and submitting 
license request” on page 2-10.

To submit a SoftJACE license request
At the SoftJACE PC, do the following

Step 1 From the Windows Start menu, click Programs > AX SoftJACE > Console
The Niagara Command Line console window appears.

Step 2 At the command prompt, enter: wb
A series of license related popup dialogs occur.

Step 3 Within a few seconds, a Bind License form appears in the default browser, in which the Niagara-
calculated host id for the SoftJACE is already entered. See Figure 7 on page 10 for an example.

Step 4 In the form, enter your license key. Also enter your name, company, and email address. 

Step 5 After completing the form (double-check your license key), click Submit.
The licensing server searches for a matching license key, and when found binds and finalizes the license. 
A License Binding Successful message appears in the browser.
NiagaraAX-3.7, -3.8
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Your license is now available from the licensing server when commissioning the SoftJACE, and it is also 
emailed to you as a license file attachment.

Figure 7 Bind License form with SoftJACE host id already entered

Manually checking host ID and submitting license request
If your SoftJACE PC does not have Internet connectivity, you can use the following two procedures to 
determine your SoftJACE host ID, then manually submit a license request. In this case, when you submit 
the license request (from another PC that does have Internet connectivity), you supply the host ID of your 
SoftJACE PC, along with your license key, item number, and contact information.

To determine your host ID
At the SoftJACE PC, do the following to determine its Niagara host ID:

Step 1 From the Windows Start menu, click Programs > AX SoftJACE > Console
The Niagara Command Line console window appears.

Step 2 At the prompt, enter: nre -hostid
The host ID displays, for example: WinSJ-37B9-D3CC-8846-5B2F.

Step 3 Carefully record the host ID string, and then close the console window.

To manually submit a license request
From another PC with Internet connectivity, do the following to manually submit a SoftJACE license 
request:

Step 1 Open a browser and enter the following URL:
http://axlicensing.tridium.com/license/request
A blank Bind License form appears, similar to that shown in Figure 7 on page 10.

Note: Alternatively, from your Workbench PC with Internet connectivity, from the Workbench menu bar you can 
select Tools > License Request Form. This launches your default browser with the same Bind 
License form. 
However, in this case note that the host ID of your Workbench PC is populated in the Host ID field. Be sure 
to clear it before entering the newly calculated host ID of the SoftJACE!

Step 2 In the form, enter your SoftJACE host ID, along with the license key. Also enter your name, company, and 
email address.

Step 3 After completing the form (double-check your host ID and license key), click Submit.
NiagaraAX-3.7, -3.8
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The licensing server searches for a matching license key, and when found binds and finalizes the license. 
A License Binding Successful message appears in the browser. Your license is now available 
from the licensing server when commissioning the SoftJACE, and it is also emailed to you as a license file.

Installing the SoftJACE license
When you make a license request, you may receive an email reply from the licensing server, with a 
(brand).license file (or archive.zip containing it) as an attachment. When you receive this license 
file, you can install it on the SoftJACE PC in either of two ways:
• Automatically, when performing SoftJACE platform commissioning (providing you have Internet 

connectivity). See “About the Commissioning Wizard” on page 2-14 for more details.
Note: If copying the received license file to your Workbench PC, it is recommended that you copy it 
to your !licenses/inbox folder. Then after doing this, close and restart Workbench.

• Directly at the SoftJACE PC, if you have access to the license file. Simply copy the (brand).license 
file into the licenses subdirectory of the Niagara installation directory, typically:
Niagara\Rel\licenses

Connect to the SoftJACE
Once the SoftJACE software is installed and its platform daemon started, you can connect to it from 
another PC running Workbench, using “Open Platform.” A platform connection to any JACE (including 
SoftJACE) is required for most host-level operations. This includes upgrading NiagaraAX core software 
and modules, installing and starting a station, and performing various other tasks.

Note: Port 30111 must be accessible on the AX SoftJACE. See “Platform daemon port” on page 2-5.
After you open a platform connection, you can run the Commissioning Wizard.
• Open a SoftJACE platform connection
• Start the Commissioning Wizard

Open a SoftJACE platform connection
Working from a PC with Workbench installed, you open a platform connection to the SoftJACE to 
commission it and install a station. Connection details vary between an AX-3.8 or AX-3.7 SoftJACE.
• “To open a platform connection to a new AX-3.8 SoftJACE” on page 2-11
• “To open a platform connection to a new AX-3.7 SoftJACE” on page 2-13

To open a platform connection to a new AX-3.8 SoftJACE
From an AX-3.8 Workbench PC, do the following:

Step 1 From the Workbench menu bar, select File > Open > Open Platform.
A Connect popup dialog appears. 

Note: You can change Session “Type” between Platform SSL and regular (non-SSL). A new AX-3.8 SoftJACE is 
pre-configured to support either a platform SSL connection or a “regular” (non-SSL) platform connection.

Step 2 In the Connect popup, enter fields as follows:
• Host

Leave at default IP, and type in the IP address or hostname of the SoftJACE PC.

1. Or port 5011 must be accessible on an AX-3.8 SoftJACE, if you want to initially connect using Platform with SSL.

AX-3.8 (SSL session type) AX-3.8 (non-SSL session type)
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• Port
Leave at default 5011 (if SSL session selected) or 3011 (if non-SSL session).

Click OK.
If the first time for an SSL type platform connection from this Workbench, an Identity Verifi-
cation warning appears, similar to that shown below. Otherwise, see Step 3.

Click Accept. This creates an “allowed hosts” certificate exemption for Workbench on this port (5011, 
if using defaults). For more details, see “SSL and certificate notes in AX-3.8” on page 2-30..

Step 3 An Authentication popup dialog appears, as below. 

In the two fields:
• Username

Enter the user name of a user who is a member of the local Windows machine's Administrators 
group.

• Password
Type in the password for this user.

Step 4 Click the OK button to accept all settings.
The Platform opens in the tree, and its Nav Container View displays in the view pane (Figure 8).
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Figure 8 Connected JACE platform (SSL session)

Note the above shows an SSL platform session, indicated by the “padlock” in the Platform icon . A 
non-SSL platform session would look identical, except for the platform icon.

Note: After you commission a SoftJACE and it reboots, in future platform sessions you will need to login using 
any new (changed) parameters—for example, Port and/or IP address.

To open a platform connection to a new AX-3.7 SoftJACE
From an AX-3.7 Workbench PC, do the following:

Step 1 From the Workbench menu bar, select File > Open > Open Platform.
A Connect popup dialog appears. 

Step 2 In the Connect popup, enter fields as follows:
• Host

Leave at default IP, and type in the IP address or hostname of the SoftJACE PC.
• Port

Leave at default 3011.
• Credentials

• Username
Type in the user name of a user who is a member of the local Windows machine's Administra-
tors group.

• Password
Type in the password for this user.

Step 3 Click the OK button to accept all settings.
The Platform opens in the tree, and its Nav Container View displays in the view pane (Figure 8).
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Figure 9 Connected JACE platform

Note: After you commission a SoftJACE and it reboots, in future platform sessions you will need to login using 
any new (changed) parameters—for example, Port and/or IP address.

Run the Commissioning Wizard
The following sections describe using the Commissioning Wizard for a new SoftJACE:
• “About the Commissioning Wizard” on page 2-14
• “Start the Commissioning Wizard” on page 2-15

• “Request or install software licenses” on page 2-16
• “Set module content filter level” on page 2-17
• “Station installation” on page 2-17
• “Install lexicons” on page 2-18
• “Install/upgrade modules” on page 2-19
• “Install/upgrade SoftJACE core software” on page 2-20
• “TCP/IP configuration” on page 2-21
• “Platform daemon authentication” on page 2-22
• “Review and finish wizard” on page 2-24

About the Commissioning Wizard
As shown in Figure 10, the Commissioning Wizard is a right-click option on any connected platform in 
the Nav tree. You can also launch the wizard from the Platform Administration view.

Figure 10 Commissioning Wizard as right-click platform option

Typically, you use this wizard when installing any new JACE, as it provides a “checklist” method to 
perform essential (and often “one time”) platform tasks. You also typically use this wizard to upgrade a 
JACE (or SoftJACE) from one NiagaraAX build or release level to another.

Note: The same tasks executed as steps in the wizard can also be performed in separately available platform 
views. In some cases, you may wish to do this instead. See “SoftJACE Commissioning Wizard notes”.

SoftJACE Commissioning Wizard notes
• If your step selection includes making any TCP/IP configuration change, the Commissioning Wiz-

ard ends with a reboot of the SoftJACE (PC). In this case, first verify that all other applications on the 
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SoftJACE are closed. This should not be an issue—any SoftJACE PC should be dedicated to Soft-
JACE (NiagaraAX) operation.

• The first part of the wizard is to select the installation steps needed. Unlike when commissioning a 
new JACE controller, when commissioning a SoftJACE you may wish to skip some of the preselected 
steps (as noted in step discussions ahead). Further, after the initial commissioning you can make fu-
ture platform connections, and either rerun the wizard or use various dedicated platform views.

• Throughout the wizard’s dialogs, use the buttons Back and Next, as needed, to retrace (or skip) 
steps. Also, the Cancel button stops any unfinished operations, and exits the wizard after your con-
firmation.

• Before committing to the final sequence of steps, the wizard provides a summary for you to review.

Start the Commissioning Wizard

To start the Commissioning Wizard
From a Workbench PC with the SoftJACE platform open, to start the Commissioning Wizard do the 
following:

Step 1 In the Nav tree, right-click on Platform and select Commissioning Wizard. The wizard dialog 
Commissioning for “<IP address>” appears.
By default, all steps are selected except lexicon installation (for language support). Steps are executed in 
the order listed in the wizard.

Step 2 As needed, click to include or omit steps. For a new SoftJACE, you may elect to clear various steps. For 
example, you may wish to clear the module content filter level step, the TCP/IP settings step, and/or the 
platform daemon authentication configuration step.
Some steps always run, e.g. the request or install software licenses step and install/upgrade modules step.

Commissioning steps include:
• Request or install software licenses — Always selected.
• Set module content filter level — Typically unnecessary, as the default module content level is the 

highest (DOC + UI + RUNTIME), which is appropriate for almost any SoftJACE host platform. 
• Install a station from the local computer — Recommended.
• Install lexicons to support additional languages — Recommended only if you are using lexicon sets 

(files) instead of lexicon modules, typically for non-English language support.
• Install/upgrade modules — Always selected, whenever wizard is run. To select the software mod-

ules, and optionally any lexicon modules for a AX-3.7 or later SoftJACE.
• Install/upgrade core software from distribution files — Preselected for any new SoftJACE.
• Sync with my local system date and time — Preselected for any new SoftJACE.
• Configure TCP/IP network settings — Optional, to configure various TCP/IP settings of the remote 

SoftJACE host (including IPv6 settings and host file settings). This provides an alternative to using 
the host’s native Windows configuration access method, e.g. via its Windows Control Panel.
Note: Any change you make in this step results in a reboot of the SoftJACE PC at the end of all steps 
executed by the wizard. For details, see “Post-wizard SoftJACE configuration” on page 2-25.

• Configure platform daemon authentication method — Optional, this allows you to change from the 
default “basic” (Windows user) authentication to “digest” authentication for platform connections 
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to the SoftJACE.

Step 3 Click the Next button to continue. The first step is “Request or install software licenses”.

Request or install software licenses

To automatically install or update licenses
At the Licensing step in the Commissioning Wizard, you can install one or more license files in the 
SoftJACE. You are sent a (brand) license file after submitting a license request, and may have already 
installed (copied it into the proper directory) while working at the SoftJACE—see “About the SoftJACE 
license” on page 2-7. If so, a dialog appears similar as shown in Figure 11.

Figure 11 License dialog ((brand) license already installed)

In this case you can choose either “Don’t change any licenses” or the “Install licenses from license server” 
option, and click Next to proceed. See “Set module content filter level” on page 2-17.

Note: A (brand) (Tridium) license file is always needed. Typically, other license files are not needed unless you 
are using third-party module(s). In this case, you can also install those license files during this same 
commissioning step.
If you did not copy the license file to the SoftJACE, but you did successfully submit a license request (see 
“Submitting a license request” on page 2-9), you can simply let the wizard retrieve and install it in the 
SoftJACE by choosing the license server option.

Figure 12 License dialog (select method)

Note: If the license server option shown above does not appear, Workbench has not detected Internet connectivity.
The third option above appears if you previously copied your received SoftJACE license file(s) into your 
Workbench PC’s !licenses/inbox folder, and subsequently restarted Workbench. Alternatively, if 
you have the JACE license file(s), you can use the next procedure “To install or more licenses from files”.

Step 1 Select “Install licenses from the license server” (or if applicable, “Install licenses from workbench license 
database”).

Step 2 Workbench silently searches the licensing server, locates the license(s), and the wizard advances to the 
next step. See “Set module content filter level” on page 2-17.

To install or more licenses from files
Step 1 At the License step, select “Install one or more licenses from files”.

Step 2 Click the Next button.
A “Choose license files to install” step appears.
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Step 3 Click the Add button.
A “Select File” dialog appears. By default, the contents of your licenses subfolder is listed (showing your 
Workbench license). If you previously pointed Workbench to another location, license files in that 
location are listed instead.
• If you see the license you need, click it to highlight it. If other licenses are also needed, you can select 

multiples by holding down the Ctrl key while you click.
• If a license is not listed, navigate to its location using the left-pane folder tree controls, and click the 

license to highlight it.
Note: The licensing tool prevents selection of a wrong license (different hostid) to install in the SoftJACE.

Step 4 Click the OK button.
The “Choose license files to install” dialog appears with the selected license(s).

Step 5 If necessary, click the Add button again (step  3) to add additional license files.

Step 6 When all needed licenses are listed in the “Choose license files” dialog, click the Next button to go to the 
next step in the Commissioning Wizard.

About the Licensing Server
For license files validated against the Tridium certificate, installation can be automated from Workbench. 
All such purchased licenses (including JACE, Supervisor, or Workstation-only) are stored and available 
to Workbench through the licensing server.
Providing that your PC currently has Internet connectivity while running a platform connection to any 
Niagara host, Workbench provides an install option (get and install the licenses for the host from the 
license server). When selected, Workbench silently searches the Tridium web portal for a license with a 
matching Host ID of the target platform. When found, it selects the license(s) and advances to the next 
wizard step. For more details, refer to the section “About the licensing server” in the Platform Guide.

Set module content filter level
Module content filter level affects how much storage space is used when installing Niagara modules. 
Usually, the default (preselected) level is appropriate for any opened JACE platform.

Figure 13 Module Content Filter Level

To specify the module content filter level
At the Module Content Filter Level step (Figure 13) in the Commissioning Wizard, do the following:

Step 1 Click the desired level of content in Niagara modules to be installed in this SoftJACE.
Module content level is one of the following:
• DOC+UI+RUNTIME —  (Default) Recommended for most installations of a SoftJACE.
• UI+RUNTIME — Appropriate if the SoftJACE is to run the Web Service, and the absolute maxi-

mum amount of drive storage is wanted for the history space, and/or other files.
• RUNTIME — Typically chosen only for a QNX-based platform not running the Web Service.

Step 2 Click the Next button for the next step, which is typically “Station installation”.

Station installation
If you have a specific station database ready to install in the SoftJACE, you can specify it at this step in 
the wizard. Or, simply accept the default “(Don’t transfer a station)” and click Next. (You can create a 
station later using the New Station Wizard, and install it using the platform’s Station Copier.)
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To specify a station database to install
At the Station Installation step in the Commissioning Wizard, do the following:

Step 1 Click the Station drop-down control and click the name of a station database on your PC.

Listed are station subfolders under your Workbench PC’s local !stations folder.

Step 2 If you select a station, the following additional selections are available:
• New Name — Either leave at same station name as local copy, or type in a new station name.
• START AFTER INSTALL — If enabled, the station starts after the commissioning completes.
• AUTO-START — If enabled, the station starts every time the JACE is started.

Step 3 Click the Next button to continue.
A dialog asks which station files to copy, where you can select one of the following:
• Copy files from selected directories — Allows you to specify which subfolders under that local sta-

tion that are copied. It produces a “tree” selection dialog upon Next button.
• If you choose this, click folder controls to expand and contract as needed.
• Selected folders appear with an “X” and unselected folders show an empty folder box.

• Copy every file in the station directory and its subdirectory — The default, most typically used.
• Copy only the “config.bog” station database file — Copies only the station configuration (compo-

nents), and not any supporting folders/files like px files, html files, and so forth.

Step 4 Click the Next button for the next step, which may be either “Install lexicons” or “Install/upgrade 
modules”.

Install lexicons

Figure 14 Lexicon Installation dialog

To install lexicons
At the Lexicon Installation step (Figure 14), you can install one or more text-based lexicon file sets in a 
new SoftJACE. Lexicons provide support for non-English languages in the JACE. Lexicons are identified 
by java locale codes, such as “fr” (French) or “de” (German).

Note: In some domestic (U.S.) installations, an English lexicon (“en”) is added and configured to globally 
“customize” items such as property descriptions in Workbench.
In order to select lexicons (file sets), they must be under a !lexicons subdirectory of your NiagaraAX 
Workbench home folder. Note that starting in AX-3.7, the Workbench installation no longer includes 
such lexicon file sets (along with your selection of them)—instead “standard” lexicons are now distributed 
as jar’ed software modules, which you select and install in the next step.
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However, if you copied such lexicons from a previous NiagaraAX Workbench release, they will be 
available to install in this step. Typically you customize (edit) them using the Lexicon Editor in 
Workbench. Afterwards, you install them in JACEs, so that each JACE has the proper changes.
To install such lexicon file sets, do the following:

Step 1 Click a language code to select (highlight) it.
If multiple lexicons are needed, hold down the Ctrl key while you click.

Step 2 When needed lexicons are selected, click the Next button for the next step, “Install/upgrade modules”.

Install/upgrade modules
This step produces a Software Installation dialog, as a table with sortable columns. During 
commissioning, you can change modules that are preselected for installation. You may not need to make 
any changes, as the wizard preselects all necessary “core” modules, plus any additional modules needed 
by the database (config.bog) of a station previously selected (see “Station installation” on page 2-17).

Note: Preselected modules based on items in the station (config.bog) do not include user interface-related 
modules for widgets or images used in Px files.

Figure 15 Example SoftJACE software selection step

In the case of a SoftJACE, the current (Workbench-like) CD or image installation already installed most 
modules. If your Workbench is running at the same or earlier build level, most (if not all) modules may 
appear listed as “Up to Date” (Figure 15). In this case, the Upgrade All Out of Date button will 
be dimmed—after selecting any other modules (if any) you can simply click Next to continue. 
However, if your Workbench is using a newer build level, you will see virtually all modules listed as “Out 
of Date”—in this case, click Upgrade All Out of Date, to select them all. 

Note: You can manage modules anytime later, using the platform Software Manager. You may wish to do 
this to remove modules that have little use by the SoftJACE’s station. As with any JACE, if you install a 
station later, the platform Station Copier will automatically prompt for confirmation to install any 
additional modules, if required by that station. 

To select modules
At the Module Installation step (Figure 15) in the Commissioning Wizard, do the following:

Step 1 Review the list of available modules (This list is long and requires you to use the scroll bar).  
Each selected module has an “X” in its selection box. Note the following:
• Modules preselected from “core” need or station database reasons each have a red text descriptor, 

which may read as:
• Install required platform module “Tridium buildNumber”
• Install module required by station “Tridium buildNumber”
By default, these modules are at the top of the list. You cannot deselect these modules.

• You can select additional modules to install by clicking selection boxes. The description for each is 
in blue text, and displays as either:
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• Not Installed (if not selected)
• Install “Tridium buildNumber” (if selected)

• To resort the list alphabetically, click the Software header in the table. To return to the default 
sort order, click the table’s (blank) description header.

• To reset the selection of modules to the original collection, click the Reset button.

The figure above is an example where the station to be installed includes some modules that were not in 
the SoftJACE image (CD). The module (software) list has been resorted alphabetically.

Step 2 Click the Next button to go to the next step, “Install/upgrade SoftJACE core software”.

Install/upgrade SoftJACE core software
At the install/upgrade core software step, a popup dialog briefly appears as the dependencies of the 
platform are compared against the distribution (dist) files available in your Workbench PC’s “software 
database.” The wizard determines what dist file(s) need to be installed, and informs you (Figure 16).

Figure 16 Example Install/upgrade core software step for SoftJACE

For related details, see the section “About your software database” in the Platform Guide.
Note: If this step determines that the SoftJACE already has all its core software at the same build level as your 

Workbench, it reports that all “core software is already up-to-date.” However, a checkbox is available to “Re-
install the core software”. If you select this, the wizard will re-install the core software when it executes.

To install the distribution file
To install the selected distribution file, do the following:

Step 1 Click Next to install the distribution file and go to the next commissioning step. Using wizard defaults, 
this is “TCP/IP configuration”.

Note: If you had selected “Sync with my local system date and time” in the beginning Commissioning dialog, 
note that this step occurs without a dialog. However, you will see it listed in the final “Review of changes” 
Commissioning dialog.
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TCP/IP configuration
Note: You may wish to skip this step if the SoftJACE PC is already pre-configured with its intended TCP/IP 

settings, or if you wish to use its local Windows Control Panel to make these type of changes. Be aware 
that a SoftJACE PC reboot occurs if you make any changes in this step, at the conclusion of the wizard.

Figure 17 Example TCP/IP configuration step for SoftJACE

Note: If the SoftJACE PC has another NIC, an “Interface 2” control with separate settings will also be 
available. Intended usage in Niagara is for isolating a “driver’s” Ethernet traffic from the primary interface. 
DHCP is typically supported in the TCP/IP configuration of both ports, and standard gateway functions 
are possible using the Windows operating system. However, it is recommended that you check with Systems 
Engineering before engineering a SoftJACE solution dependent on multiple Ethernet interfaces. 
As shown above, IPv6 settings are available too (however, most are read-only for any Windows-based host). 
For more complete details on TCP/IP configuration from a Niagara platform connection, refer to the 
Platform Guide section on TCP/IP Configuration, including the section “TCP/IP changes in AX-3.6”.

To configure TCP/IP settings
At the TCP/IP Configuration step (Figure 17) in the Commissioning Wizard, do the following:

Step 1 Review the “Interface 1” IPv4 Settings, which reflect the address you used to make the 
connection.

Step 2 If needed, assign the SoftJACE another unique IPv4 address for the network. No other device on the 
network should use the same IP address. Include the appropriate IPv4 subnet mask used by the LAN.
Alternatively, if the network supports DHCP, you can enable it (click DHCP Enabled). In this case, the IP 
Address and Subnet Mask fields become read only.

Note: In general, for stability, static IP addressing is recommended over DHCP. If using DHCP, an address reser-
vation (for the SoftJACE host in the DHCP server) is recommended. 
Do not enable DHCP unless you are certain that the network has DHCP servers!  
Otherwise, the SoftJACE may become unreachable over the network.

Step 3 Review, and if needed adjust other TCP/IP settings, which (in usual order of importance) include:
• IPv4 Gateway — The IP address for the device that forwards packets to other networks or subnets.
• DNS Domain —  Type name of network domain, or if not applicable, leave blank.
• Hostname — The current host name, or the name you want to use for this host.
• Hosts File — Click control to expand edit field. Format is a standard TCP/IP hosts file, where each 

line associates a particular IP address with a known host name. Each entry should be on an individual 
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line. The IP address should be placed in the first column, followed by the corresponding host name. 
The IP address and the host name should be separated by at least one space.
1. To add a line, click at the end of the last line and press Enter.
2. Type in the required data on the new line.
3. To return to see all TCP/IP settings, click the control to contract the edit field when done.

Note: The Undo Changes button resets all settings (all Interfaces) back to the original pre-step values.

Step 4 Click the Next button to go to the next step, which may be “Platform daemon authentication”.

Platform daemon authentication
At the platform daemon authentication step (Figure 18) in the wizard, you specify whether to use “basic” 
(Windows user) or “digest” authentication for platform login access to the SoftJACE. The default is basic 
authentication. If you select digest instead, you can further specify the single user name and password. 
Always consider platform daemon access as the highest-level access to any JACE.

Figure 18 Platform Daemon Authentication dialog (choose method)

Note: You may wish to skip this step if you are using basic authentication, and the SoftJACE is already pre-
configured with its intended collection of Windows users and groups. Or, you may wish to use its local 
Windows Control Panel to make these type of changes.
You can also do this after the wizard completes, via the platform’s User Manager view. For more 
details, see the “User Manager” section in the Platform Guide.
The following procedures apply to both authentication methods:
• To specify basic platform daemon authentication
• To specify digest platform daemon authentication

Note: Following your initial commissioning of the SoftJACE, you can always change the platform authentication 
method, using the “Update Authentication” option in the Platform Administration view.

To specify basic platform daemon authentication
To specify basic platform daemon authentication, do the following:

Step 1 In the choose method dialog (Figure 18), leave the top (“Use basic”) selection checked, and click Next.
A popup for Username and Password may appear, as shown below.

Step 2 Use your standard Windows login credentials—if the host is on a Windows domain, login using the 
credentials you use when logging into that domain. This is necessary to limit the number of possible 
domain groups to only those groups in which you are a member. Such groups will be selectable in the next 
dialog for basic platform authentication.

Step 3 After entering these credentials, click Next.
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A popup for selecting Windows user groups and the “station admin access” selection appears.

Step 4 In the User Group field, select the Windows user group to have access to most platform tools (default 
selection is BUILTIN\Users).

Step 5 In the Admin Group field, select the Windows user group to have access to all platform tools, including 
the ability to modify TCP/IP settings, reboot the SoftJACE, and change date and time (default selection 
is BUILTIN\Administrators).

Step 6 In the Stations area, a checkbox allows you to enable a station user to change TCP/IP settings, system 
time, or rebooting the host by accessing the station's PlatformServices. Such a station user must have 
admin write privileges on the PlatformServices component in the station, or else be a super user.

Note: By default, this option is cleared. 

Step 7 Click the Next button to advance to the final “Review and finish wizard” dialog.

To specify digest platform daemon authentication
To specify digest platform daemon authentication, do the following:

Step 1 In the choose method dialog (Figure 18), check the bottom (“Use digest”) option, then click Next.
A dialog for entering the digest credentials appears.

Note: Digest user name and password entries are both case sensitive.

Step 2 In the User Name field, type in the desired user name for platform login.
The digest platform user name in a SoftJACE can be any “non-empty” combination of characters, 
including alphanumeric (a - z, A - Z, 0 - 9), spaces, and/or punctuation.

Step 3 In the Password fields, type in the desired password (it must match in both password fields).
Entry characters display only in asterisks (*).
Password can be any desired length and mix of characters (“strong” passwords are supported).

Step 4 Click the Next button to advance to the final “Review and finish wizard” dialog.
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Review and finish wizard

Figure 19 Example review changes commissioning wizard dialog for SoftJACE

To review and finish the Commissioning Wizard
After the final selected step in the Commissioning Wizard, a “Review of changes” dialog appears, as 
shown in Figure 19. It lists a summary of all remaining actions to be performed by the wizard.
Before proceeding:

Step 1 Read through the summary of changes, using the scroll bar to see those steps near the end.
• If no change is needed, click the Finish button to initiate the rest of the Commissioning Wizard. 
• If any change is needed, click the Back button until the step dialog appears, then make the change. 

Then, click the Next button until this review dialog appears again. 

Step 2 While the wizard is working, progress updates are posted in a “Completing Commissioning” dialog. 
When the wizard completes, a “Close” button is available. If any TCP/IP changes were made, the wizard 
reboots the SoftJACE.

Step 3 Click the Close button to exit the wizard.
If the SoftJACE reboots, your platform connection to it drops. Notice that in the Nav tree, the platform 
instance for it is now dimmed. 
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Step 4 If you changed the IP address of the SoftJACE, close that platform instance, as it is now invalid.
Note: Going forward, you must access the SoftJACE by its new IP address (if changed). Note that your Workbench 

keeps a history of TCP/IP changes made. Also, remember to login using any new assigned platform creden-
tials, see “Platform daemon authentication” on page 2-22.

Note: Allow at least 2 minutes for the SoftJACE to reboot, before reopening a platform connection to it.
After running the Commissioning Wizard, you may still need to do some NiagaraAX platform configu-
ration for the SoftJACE. See “Post-wizard SoftJACE configuration”.

Post-wizard SoftJACE configuration
Some additional SoftJACE platform configuration may remain after running the Commissioning Wizard, 
depending on your installation needs. The following topics apply:
• “SoftJACE platform administration” on page 2-25
• “SoftJACE Platform Services” on page 2-28
• “Software port notes” on page 2-30

SoftJACE platform administration
The Platform Administration view is one of several views for any platform, listed under the platform in 
the Nav tree side bar (Figure 20).

Figure 20 Platform Administration is one of several platform views

Included in this view are commands and related dialogs in which you can:
• Set the date and time in the SoftJACE.

Typically, this is needed only if you did not choose to “sync” with your local system date and time 
when running the Commissioning Wizard.

• Change the HTTP port used by the SoftJACE for a “non-SSL” connection to its Niagara platform 
daemon (platform server), if used. The default port is 3011.

• Change SSL settings used by the SoftJACE to enable/disable and otherwise specify a secure connec-
tion (SSL and/or TLS) to its Niagara platform daemon (platformssl server). The default port is 5011.

• View a simple text summary of the SoftJACE’s current software configuration, including its OS level, 
JVM version, installed modules, lexicons, licenses, certificates, and so on.

• Use debug-level tools to change logging levels and view platform daemon output.
• Perform other platform tasks available using the Commissioning Wizard, such changing platform 

authentication (platform’s username and password), and so on.
For more details, see the Platform Administration section in the Platform Guide. For a procedure specific 
to a new SoftJACE, see the next section “Administer the SoftJACE platform”.

Administer the SoftJACE platform

To perform platform administration
From your Workbench PC, with the SoftJACE already commissioned using the Commissioning Wizard:

Step 1 Open a platform connection to the SoftJACE, if not already opened.
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Use the procedure “Open a SoftJACE platform connection” on page 2-11, except use any changed IP 
address, port, or credentials (if applicable).

Step 2 In the SoftJACE platform’s Nav Container View, double-click Platform Administration.
The Platform Administration view appears (Figure 20).

Step 3 As needed, click the following buttons to review or make changes:
• View Details — For a platform summary that you can copy to the Windows clipboard.
• Update Authentication — For platform daemon authentication dialog to change platform lo-

gin authentication method (as previously included as step in commissioning wizard).
• Change HTTP Port — For a dialog to change the HTTP port for “non-SSL” connections to the 

SoftJACE’s platform daemon from port 3011 to some other port. See “Change HTTP Port” on page 
2-26. Note this port is not used if specifying “SSL only” for platform connections,

• Change SSL Settings — Provides a dialog to enable/disable secure SSL/TLS connections to 
the host’s platform daemon, specify the TCP port used for such connections, plus specify other re-
lated settings. See “Change SSL Settings” on page 2-27.

• Change Date / Time — For dialog to change the SoftJACE’s current date, time, and time zone 
(as previously included as step in commissioning wizard).

• Change Log Settings — Provides dialog to change the log level of different processes that can 
appear in the platform daemon output.

• View Daemon Output — Provides window in which you can observe debug messages from plat-
form daemon processes in real time. Also includes ability to pause or load.

• Set Module Filter — Provides dialog to change the module content level of the SoftJACE (as 
previously included as step in commissioning wizard).

• Backup — Make a complete backup of all configuration on the connected host platform, including 
all station files as well as other Niagara configuration (typically unnecessary for any host just started 
up).

• Commissioning — Another way to re-launch the Commissioning Wizard, as previously used in 
the initial commissioning of the SoftJACE.

• Reboot — Provides a method to reboot the SoftJACE PC, which restarts all software including the 
OS and JVM, then the platform daemon, then (if so configured in the Application Director) 
the installed station. If you click this, a confirmation dialog appears.
If you reboot, your platform connection is lost, and it is typically a couple of minutes until you can 
reconnect to this host. Note that a reboot is not necessary if you manually stopped the SoftJACE sta-
tion from the Application Director (unlike with a QNX-based JACE, you can Start it again without 
a reboot).

Change HTTP Port This step is optional, and the default port 3011 is typically used in many Niagara 
installations. However, for reasons of additional security or perhaps firewall issues, you may need to 
change the HTTP port used by the SoftJACE’s platform daemon.

Note: If you change this port, you may be unable to reopen a platform connection without first adjusting the 
firewall on the SoftJACE, particularly if it was previously set to port 3011 (see Figure 2 on page 5). In 
addition, for the strongest security it is best to configure the SoftJACE for “SSL only” platform connections, 
making this selection less important. See “Change SSL Settings” on page 2-27 for further details.

To change HTTP port
From the Platform Administration view (Figure 20 on page 25):

Step 1 Click the Change HTTP Port button.
A dialog appears showing the current HTTP port number highlighted.

Step 2 Type in the new HTTP port number and click OK.
In a current (non-SSL) platform connection, the Platform Administration view refreshes in a few 
seconds, and the SoftJACE platform node remains opened in the Nav tree, showing the new HTTP port 
number (:n) in parenthesis by the platform icon.
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Note: Before closing the host (removing it from Nav tree), carefully note the new (non-default) port number you 
entered. You must specify that port number whenever reopening the SoftJACE platform.
Note any station running on the SoftJACE tracks both the configured port number and SSL port number 
used to access the platform daemon, as read-only properties of the station’s PlatformServices container:
• Platform Daemon Port
• Platform Daemon SSL Port
For an example showing these two properties, see Figure 23 on page 29.
Change SSL Settings This step is optional, but necessary for the strongest security. We recommended 
to not just enable platform SSL on the SoftJACE, but to further configure it for “SSL Only” connections.

Figure 21 Change SSL settings dialog (default settings for AX-3.8 SoftJACE shown)

Note: By default in AX-3.8, a SoftJACE installation has SSL enabled, referencing its local self-signed “tridium” 
certificate (automatically generated upon installation). Default SSL settings are as shown above. This 
differs from an AX-3.7 SoftJACE, where the default platform SSL state is “Disabled”. 
The following procedure includes brief descriptions of choices in the Platform SSL Settings 
dialog. Find complete details about NiagaraAX SSL usage in the NiagaraAX SSL Connectivity Guide.

To change SSL settings
From the Platform Administration view (Figure 20 on page 25):

Step 1 Click the Change SSL Settings button.
A Platform SSL Settings popup appears showing a number of settings.

Step 2 Set State to one of the following:
• Disabled — Secure platform connections not possible (only regular platform connections).
• Enabled — Secure platform connections permitted, as well as regular platform connections.
• Ssl Only — Only secure platform connections are allowed. Any attempt to open a regular platform 

connection either goes unresolved (AX-3.8), or else in AX-3.7 is automatically redirected to the port 
servicing secure platform connections.

Step 3 Specify Port to use for secure platform connections, where port 5011 is the default.
Note: If you change this port, you may be unable to reopen a platformssl connection without first adjusting the 

firewall on the SoftJACE, particularly if it was previously set to port 5011 (see Figure 2 on page 5).

Step 4 In Certificate, you select the server certificate “alias” in the SoftJACE’s “key store” to use for 
platformssl. The default (and only) available certificate in a newly-installed SoftJACE is a self-signed one 
named tridium. If another certificate is imported (later) into the key store, you can select it using the 
drop-down control. For complete details, refer to the document NiagaraAX SSL Connectivity Guide.

Step 5 Set Protocol to specify the protocol used for secure platform connections, as either:
• SSLv3 — Only SSL version 3 (Secure Socket Layer) is used.
• TLSv1 — Only TLS version 1 (Transport Layer Security) is used. Automatically set for any AX-3.8 

SoftJACE configured for FIPS 140. For details, see the NiagaraAX FIPS 140 Configuration Guide.
• SSLv3+TLSv1 — (Default) Either TLS version 1 or SSL version 3 can be used for the platform con-

nection. This is the default, and is typically recommended.
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Step 6 Click Save.
Note if you changed Port during a current platformssl connection, another “Identity Verification” popup 
warning may appear. See “SSL and certificate notes in AX-3.8” on page 2-30. After you accept, the 
Platform Administration view momentarily refreshes, and the SoftJACE platform node remains opened 
in the Nav tree, showing the new HTTP port number (:n) in parenthesis by the secure platform icon.

Note: Before closing the host (removing it from Nav tree), carefully note the new (non-default) port number you 
entered. You must specify that port number whenever reopening the SoftJACE platform with SSL.
Note any station running on the SoftJACE tracks both the configured port number and SSL port number 
used to access the platform daemon, as read-only properties of the station’s PlatformServices container:
• Platform Daemon Port
• Platform Daemon SSL Port
For an example showing these two properties, see Figure 23 on page 29.

SoftJACE Platform Services
Some platform configuration is possible only by accessing platform services in a station running on that 
host. Although such SoftJACE configuration is optional, you may want to do it during the initial commis-
sioning. Under its Services container, any station has a PlatformServices container (Figure 22).

Figure 22 SoftJACE station’s PlatformServices

PlatformServices is different from all other components in a station in the following ways:
• It acts as the station interface to specifics about the host platform (whether JACE or a PC).
• It is built dynamically at station runtime—you do not see PlatformServices in an offline station.
• Any changes you make to PlatformServices or its child services are not stored in the station database.

Instead, changes are stored in other files on the host platform, such as its platform.bog file.
Note: Do not attempt to edit platform.bog directly; always use PlatformServices’ views!

For a SoftJACE, the main platform service items of interest during commissioning may involve these two 
child platform services (and possibly one or two of the parent container’s PlatformService properties):
• CertManagerService

This service provides a Certificate Management view, with the means to import and export 
signed certificates (for SSL or TLS secure connections) into the platform's key store and trust store, 
and to perform other related functions.
For complete details, refer to the document NiagaraAX SSL Connectivity Guide, including the sec-
tion “About the Certificate Management view”.

• NtpPlatformServiceWin32
This service is the NiagaraAX interface to the Windows Time service (W32Time) on the SoftJACE’s 
Windows OS (either 32-bit or 64-bit). This Windows service uses the SNTP (Simple Network Time 
Protocol) to synchronize to one or more designated time servers. The default view of this platform 
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service is the Ntp Platform Service Editor Win32 view, in which you can adjust a few set-
tings of the Windows Time service, including identifying NTP time servers.
For more details, refer to the NiagaraAX Platform Guide sections “About the Ntp Platform Service” 
and “About the Ntp Platform Service Editor Win32”.
Note: NTP requires use of UDP port 123—if using NTP, you typically need to make a firewall 
exception to allow UDP port 123 traffic. 

Note: Unlike in a station running on a QNX-based JACE, a SoftJACE has no “power monitoring” (PowerPlat-
formService, as in a QNX-based JACE or JACE-NXT), or “system monitoring” (HardwareMoni-
torService, as in a JACE-NXT). There is no HardwareScanService available either. Finally, the 
SerialPortPlatformService has read-only properties only.
Note there is also a TcpIpService and LicenseService, providing station (Fox) access to dialogs 
used in platform views, for instance the TCP/IP Configuration dialog as shown in Figure 17 on page 21. 
These platform services support installations where all configuration must be possible using only a 
browser connection (and not Workbench connected to the SoftJACE’s platform daemon).

PlatformServices properties in a SoftJACE

Figure 23 Properties of PlatformServices container in a SoftJACE

To review PlatformServices properties for the SoftJACE
With a station in the SoftJACE running, and that station opened in Workbench, do the following:

Step 1 In the Nav tree, double-click Services and then PlatformServices.
Its property sheet displays in the view pane, as shown in Figure 23.
Many are read-only status types, similar to what is available in the Platform Administration view. Other 
configuration properties are available. A group of 3 properties allow adjustment of the time, date, and 
time zone settings for the host SoftJACE (alternately accessible using a platform connection to it). Access 
to these properties is useful if the installation requires all setup access using a browser only.

Step 2 As needed, review other platform service configuration properties, which include the following:
Note: It is strongly recommended that you leave the following properties at default values, unless otherwise 

directed by Systems Engineering.
• Locale — Determines locale-specific behavior such as date and time formatting, and also which 

lexicons are used. A string entered must use the form: language [“_” country [“_” variant]]
For example U.S. English is “en_US” and traditional Spanish would be “es_ES_Traditional”.
For details, see Oracle documentation at http://docs.oracle.com/javase/7/docs/api/java/util/Lo-
cale.html.

• Engine Watchdog Policy — Defines response taken by the platform daemon if it detects a sta-
tion engine watchdog timeout. With the watchdog, the station periodically reports to the platform 
daemon its updated engine cycle count. The watchdog purpose is to detect and restart a “hung” or 
“stalled” station, and is automatically enabled when the station starts.
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Watchdog policy selections include:
• Log Only — Generates stack dump and logs an error message in the system log.
• Terminate — (Default) Kills the VM process. If “restart on failure” is enabled for the station 

(typical), the station is restarted.
• Reboot — Automatically reboots the host JACE platform. If “auto-start” is enabled for the sta-

tion, the station is restarted after the system reboots.
• Engine Watchdog Timeout — Default is 1 minute, and range is from 0 ms to infinity.

If the station’s engine cycle count stops changing and/or the station does not report a cycle count to 
the platform daemon within this defined period, the platform daemon causes the VM to generate a 
stack dump for diagnostic purposes, then takes the action defined by the Engine Watchdog Policy.

• Engine Station Auto-Save — Either Enable (default) or Disable.
Allows for “auto save” of running station to “config_backup_<YYMMDD>_<HHMM>.bog” file at the 
frequency defined in next property. Auto-saved backup files are kept under that station’s folder.

• Station Auto-Save Frequency — Default is every (1) hour for the SoftJACE, the range is 
from 1 to many hours.

• Station Auto-Save Versions to Keep — Default is 3. Oldest of kept backups is replaced 
upon next manual save or auto-save backup, once the specified limit is reached.

Step 3 Click Save to write any configuration change to host platform.

Software port notes
An AX SoftJACE platform is a customer-supplied Windows computer. Invariably, a local firewall is 
operating on this host—typically the Windows Firewall, built into the host’s Windows OS.
Firewall operation on a SoftJACE should continue during normal operation, to help maintain overall 
security. However, and as needed, selected software ports (TCP and UDP) need to be opened for inbound 
access in order to allow operation of various functions and drivers. 
This is needed even for Workbench platform access, as covered in “Platform daemon port” on page 2-5. 
Table 2-1 lists a few commonly used (default) ports used by a NiagaraAX platform running a station.
Open SoftJACE firewall access to the ports below, as applicable.

Table 2-1 Default software ports (TCP and UDP) commonly needed for SoftJACE operation

Only a few of the various IP-based drivers are included above—refer to a specific NiagaraAX driver 
document for more IP port usage details.

SSL and certificate notes in AX-3.8
Note: This section explains a little more about the Workbench SSL certificate warning seen in the section 

“Connect to the SoftJACE” on page 2-11. Note that in AX-3.8, a few SSL-related changes were made since 
the releases for AX-3.7/AX-3.7u1 that affect an AX SoftJACE, which are also described below.
It is safe to “Accept” the certificate (Identification Verification) warning seen in 
Workbench when following the steps in “Connect to the SoftJACE” on page 2-11. However, don’t assume 
that always accepting similar certificates is the correct choice. An overview with a few background details 
is below. For complete details about SSL and NiagaraAX, refer to the NiagaraAX SSL Connectivity Guide.

TCP port UDP port Usage
3011 — Niagara platform connection (non-SSL default)
5011 — Niagara platformssl connection (SSL default)
1911 1911 Niagara Fox non-SSL defaults (Workbench, station-to-station)
4911 4911 Niagara Fox SSL defaults (Workbench, station-to-station)
80 — HTTP, Hx access to a station (WebService non-SSL default)
443 — HTTPS access to a station (WebService SSL default)
25 — Email SMTP default
587, 465 Email SSL SMTP defaults
— 123 NTP (Network Time Protocol), fixed
— 47808 BACnet/IP (conventional port), default
502 — Modbus TCP (conventional port), default
— 161, 162 SNMP, SNMP Trap (conventional ports), defaults
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Since AX-3.7, NiagaraAX has included integral support for industry-standard Secure Socket Layer 
(SSLv3) and Transport Layer Security (TLSv1) protocols, via an “SSL Toolset”. Included are Workbench 
tools for managing PKI (Public Key Infrastructure) digital certificates or “self-signed” digital certificates, 
which are used in verifying SSL connections. When you install an AX SoftJACE, a local self-signed 
“tridium” certificate is generated on it, and is available for (default) SSL usage by that host.
• In AX-3.7 (and AX-3.7u1), after installing a SoftJACE you could optionally enable SSL for platform 

connections. To do this, you make a regular (non SSL) platform connection to it, say to run the Com-
missioning Wizard, then access its Platform Administration view. By default, its “tridium” 
certificate is presented to any Workbench client that attempts an SSL platform connection.

• In AX-3.8 this changed—now when you install a SoftJACE, platform SSL is already enabled by de-
fault—again, using its self-signed “tridium” certificate.

In either case just described, when you open the first platform SSL connection from Workbench (the 
client) to the SoftJACE’s platform daemon (a server), Workbench presents a warning “Identity 
Verification” popup that shows you the details of its local self-signed “tridium” certificate.
• If you Accept, an “allowed host” exemption is created for your Workbench (client), and you pro-

ceed to the Authentication dialog to enter your platform credentials. This warning should not 
appear again unless you delete the allowed host exemption, or unless the certificate expires.

• If you Reject, no exemption is created, nor do you see the Authentication dialog to make a 
connection. Instead, an error message is generated.

Note this Workbench certificate warning repeats when you use Workbench to open the first station SSL 
connection (Foxs) to any station running on the SoftJACE When you click Accept, yet another “allowed 
host” exemption is created for your Workbench client, this time for a different software port: 4911 Foxs 
default, (vs. 5011 platformssl default). Similarly, secure web browser (HTTPS) access of a station running 
on the SoftJACE produces a warning in your client browser.
In general, usage of PKI signed certificates with NiagaraAX is recommended over the (default) self-
signed “tridium” certificate. However, details are well outside the scope of this document. Again, refer 
to the NiagaraAX SSL Connectivity Guide for complete details.

AX SoftJACE FAQs
The following is a list of frequently asked questions (FAQs) about the NiagaraAX SoftJACE:

Q: When a new NiagaraAX SoftJACE CD is released, do I install it on an existing SoftJACE?
A: No. After the initial software installation from CD, you do not install from a CD again. Instead, you 

administer the SoftJACE NiagaraAX software remotely from Workbench using a platform connection 
(just as with any JACE controller).

Q: What difference is there in the NiagaraAX software between a SoftJACE and say, a JACE-NXT 
controller?

A: Very little, in fact the same files are used. Differences are mainly in licensing and support for modules.
Q: Why can’t I connect to the SoftJACE from another PC running NiagaraAX Workbench?
A: Check to see if a firewall program on the SoftJACE is preventing access. In general, you should disable its 

local firewall while first setting up, then after initial NiagaraAX configuration, enable the particular port 
and protocol access you might need. See “Platform daemon port” on page 2-5 and “Software port notes” 
on page 2-30.

Q: Can I run multiple stations in a SoftJACE? I noticed that the Station Copier only lets me install one.
A: Only one running station is supported on a SoftJACE.
Q: Can I start and stop the SoftJACE station directly at the SoftJACE host PC?
A: No, there is no provision for this. Consider the SoftJACE as “another JACE controller,” which you 

routinely administer remotely from another NiagaraAX PC, via a platform connection in Workbench. 
Again, this is also how you should install future software upgrades to the SoftJACE, and do other 
NiagaraAX maintenance operations.

Q: Should I run any of the “Install_Type_Tunnel.exe” or similar files included in the SoftJACE CD 
or image on the SoftJACE host?

A: No, those files are not intended for use on the SoftJACE host. See Figure 1 on page 3 and its accompa-
nying explanation for more details.
The only installation executable you should run at the SoftJACE host is either setup_x64.exe (typical) 
or else setup.exe. See “Notes on 32-bit versus 64-bit SoftJACE installations” on page 2-4.
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Document change log
Updates (changes/additions) to this AX SoftJACE Install & Startup Guide document are listed below.
• Revised: December 16, 2013

Completely reworked document to include many changes since 2006, including several specific to 
AX-3.8 and AX-3.7. Complete details are too numerous to list, but the main areas of change include:
• The beginning “Product Description” section was revised to mention SSL capabilities, a 64-bit 

installation option, and the possibility of installing from a downloaded SoftJACE image file in-
stead of only a SoftJACE CD. See the new subsection “Download and extract the SoftJACE im-
age” on page 2-3.

• The “Installation and startup overview” section has a new subsection “Notes on 32-bit versus 
64-bit SoftJACE installations” on page 2-4. Subsection “Platform daemon port” on page 2-5 was 
updated to show the Windows Firewall in Windows 7, and mention platform SSL access.

• The “Install the SoftJACE software” section now shows the appropriate install wizard steps for 
installing NiagaraAX software for an AX-3.8 or AX-3.7 SoftJACE.

• The “SoftJACE licensing considerations” section was updated, showing the new “Bind License” 
form served by the licensing server. See “Submitting a license request” on page 2-9.

• The “Open a SoftJACE platform connection” on page 2-11 includes separate procedures for 
AX-3.8 and AX-3.7, as platform connection dialogs vary between the two. A new AX-3.8 Soft-
JACE (unlike a new AX-3.7 SoftJACE) also supports an initial “platform with SSL” connection.

• The “Run the Commissioning Wizard” section was completely revised, showing the reordered 
wizard steps in the subsection “Start the Commissioning Wizard” on page 2-15. Subsequent 
subsections describe each possible wizard step, reflecting AX-3.8 and AX-3.7 step choices.

• The former “SoftJACE configuration notes” section was retitled “Post-wizard SoftJACE config-
uration”, where both subsections “SoftJACE platform administration” on page 2-25 and “Soft-
JACE Platform Services” on page 2-28 were revised. A new subsection was added in the former, 
“Change SSL Settings” on page 2-27. In the latter on SoftJACE Platform Services, platform ser-
vices for SSL certificate management and NTP time synchronization were mentioned, includ-
ing references to other NiagaraAX technical documents where more details can be found.

• Two new sections were added, “Software port notes” on page 2-30 and “SSL and certificate 
notes in AX-3.8” on page 2-30. The first provides default software port numbers commonly 
used in NiagaraAX. This may be useful when configuring the firewall on a SoftJACE, as de-
scribed in the section “Platform daemon port” on page 2-5. The second provides background 
details on the popup “Identity Verification” warning, seen when making an initial platform SSL 
connection (as in “To open a platform connection to a new AX-3.8 SoftJACE” on page 2-11).

• The section “AX SoftJACE FAQs” on page 2-31 was updated with an additional question about 
which installation files on the SoftJACE CD (or image) actually apply to the SoftJACE host.

• Revised: November 29, 2006
Modified licensing discussions to explain the online submission for a license request. In the “About 
the SoftJACE license” section, added a new section “Submitting a license request”, and changed an-
other section to “Manually checking host ID and submitting license request”. Also separated proce-
dures under the “Request or install software licenses” step under the “Run the Commissioning 
Wizard” section. Added one additional FAQ in the “AX SoftJACE FAQs” section, to state that Soft-
JACE installation from CD should happen only once.

• Revised: November 8, 2006
In the “SoftJACE Windows security notes” section, added a new section “Platform daemon port”. 
Reworked the section “Install the SoftJACE software” to reflect the improved AX-3.1 SoftJACE in-
stallation wizard, which asks fewer questions and automatically installs and starts the needed Niaga-
raAX platform daemon. In the various step sections under “Run the Commissioning Wizard”, made 
numerous small changes and removed notes about the SoftJACE rebooting if a station is installed 
(this was fixed). Updated the majority of screen captures used in the document.

• Publication: February 7, 2006
Initial document.
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